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Audacity

Audacity e um Software Livre de edicado digital de audio,

disponivel principalmente nas plataformas: Windows, Linux e Mac
e ainda em outros Sistemas Operacionais.

O codigo fonte do Audacity esta sob a licenca GNU General
Public License.
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Audacity

Audacity e um Software Livre de edicado digital de audio,
disponivel principalmente nas plataformas: Windows, Linux e Mac
e ainda em outros Sistemas Operacionais.

O codigo fonte do Audacity esta sob a licenca GNU General
Public License.

Alguns dos recursos do Audacity incluem:

Importacao e exportacao em formato WAV, MP3, Ogg Vorbis, e
outros

Gravacao e reproducao de sons

Edicao simplificada: Cortar, Copiar, Colar e Apagar

Mixagem em multiplas faixas

Efeitos digitais de som

Remocéao de ruidos

A habilidade de alterar a velocidade do som, sem alterar spa
altura, para sincronizacao perfeita com video (em dublagens)
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Abrindo o Audacity

Para abrir (executar) o programa Audacity no Linux
(Ghome)

Aplicacoes > Multimidia > Audacity

Arquive Editar Exibir Faixas Inserir Efeitos Analisar Ajuda

Ou se preferir, =5
também pode abrir
pelo terminal.

rrrrrr
...............

Abra um terminal e
Igite: audacit
g # Taxa do Projeto Inicio da Seleg&o: @ Final () Tamanho Posigio do audio:
Antecipagéo [| 00h00mO0s» O0hO0OmOO sw 00hO0DmOOs=

444444
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Abrindo um arquivo de audio

Para abrir (importar) um arquivo de audio selecione
na barra de menu (superior) as opcoes.

Arquivo > Importar > Audio

b Audacity E] [@] [ﬁ] .

‘ |Editar Exibir Faixas |Inserir Efeitos Analisar Ajuda

T = E| E|
Nox.lfo Crri+N > | 1= ¢ Bl —p| e
Abrir... Ctrl4+0 |* Pley x| v 240 pv 220
Arguivos recentes b - ==
4 [l maj@ ] o] s[plo]e
Eechar Ctr+W -
2,0 3,0 4,0 5,0 6,0 7,0

| Salvar projeto como...

\erificar Degendéncias. 3

Abrir editor de Metadados. ..

Titulos...
MIDI...
Dados sem formatacgao...

Aplicar arguivo de lote. ..
Editar arguivos de |ote...

Saic , Ctri+Q da Selegéio: @ Final () Tamanho Posigéo do audio:

44100 | v Antecipacio [] |00h00m00s~ (0000 mOO s~ 00h00mO0 s+ 6
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Abrindo um arquivo de audio

Se a Interface estiver em inglés:

File > Import > Audio...

“h Aldacity E] @] [ﬁ] l

i, b A ‘ |Editar Exibir Faixas |nserir Efeitos Apalisar Ajuda
=i E E
AFQUIVOS de audio = o) L E o et
Abrir... Ctrl4+C | * " 54 ' g 24 0
Arguivos recentes > + [ [ mgy [E—‘_L TR R e pop- ,;’;F ):_J‘
gue O udacity o e -
2,0 3,0 4,0 5,0 6,0
| Salvar projeto como...
consegue a rir:
Abrir editor de Metadados...
AlFF, AU, FLAC,
MiDI...
MP2, MP3, OGG
) )
e |ote

Vorbis and WAV

__ 0
=
£ [
A
=}
=}

<
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Abrindo um arquivo de audio

=) Clipe som 13 =B
Arquivo Editar Exibir Faixas Inserir Efeitos Anpalisar Ajuda
T = E E
| | T %1025 15l
'I -t\-l gl __j 1 1 1 ' I 1 1 1 ' 1
Ao kD A w24 Dﬁv -24 0
W5 PO AEE S ARSI RIS I PP AP el
~ o +
x|Clipe so w
Maono, 8000Hz
32-hit flut
Mudo | Solo
.o +
E 0 L
A
[<] i | B
Taxa do Projeto Inicio da Selegdo: @ Final O Tamanho Posigdo do dudio:
18000 | v Antecipacio [| 00 h00mO00sv (00h00mOO s¥ 00hOOmMOO s

| |Ta>c:a atual 8000 8
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Executando o arquivo de audio

Para executar um arquivo de audio “clicar’” o botao
“Executar” (Play) qgue fica no canto superior esquerdo
da janela do Audacity:

Arguivo Editar Exibir

ecutar (=

1)) ) *)}
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Selecionando o dispositivo de audio

Se aparecer mensagem de erro:
“Erro ao acessar o dispositivo de som’
verifigue qual o dispositivo de audio estd sendo

usado. e
grquivol lEgibir Faixas |Inserir Efeitos Analisar Ajuda
El El
n D|‘ 1 T i 0 | D|‘ 1 v ) U |
4 - 24 0 ’ﬁ hd 24 0
9 G iy o (x| @) 220
el m
j -1,0
Are m tftul
Sel Foo
Va em Editar >
(44100 f

Preferéncias




17:47:09

Selecionando o dispositivo de audio

E em seqguida clique na opcao “Dispositivos”’ e em
“Dispositivo” selecione “Alsa: default”

€ Aplicagdes Locais Sistema Fc) = ne o) fé"g@wg Séb 22 jun, 13:10 &
& Audacity
ALSA: HDA Intel: AD198x Digital (hw:0,1) Blisar Ajuda
e | ALSA: iec958 is do Audacity
i Gravacao
Qualidade = | 2| || Dispositive: | ALSA: defautt =
Importar / Ex i - '
- Utilizando: Canais: | 2 (Estéreo) 2 |
Espectrogra™ Gravac@o e reproducdo simultaneas
Pastas Ao gravar, reproduzir outras faixas simultaneamente
l:\l"‘leclado [J Reprodugao simulténea via software (desabilite ao gravar em estéreo)
ouse
Previséo de efeitos Previsdo de recorte
Tamanho da previsao: segundos Prever antes da area recortada: segundos
Prever apds a érea recortada: segundos
Laténcia- Intervalo de busca ao reproduzir
Cépiar audio na meméria: - il Perfodo curto: |1 segundos
(maior = mais laténcia) 100 | milisegundos 2
3 &ncia: Periodo longo: [15 | segundos
Corrggao_de Iatenlda. millsegundos g g
(negativo = retroativo)
I T3
‘egancelar‘ [ <JoK

Ik

@ | & Audacity || 8 nei@malgas: ~/Pimen... | Elm
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Executando o arquivo de audio

Para dar uma pausa pressione o botao “Pausar’ e
pressione novamente para continuar a execucao.

Arguivo Editar Exibir

1) ) 1,

E para parar pressione o botao "Parar”

Arguivo Editar Exibir

A B 4
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Trilhas ou Faixas ou Pistas

As trilhas ou pistas de audio, no Audacity
denominadas em geral de “faixas”, sao as
representacoes visuals, no tempo, dos arquivos de
audio digital.

& Clipe som 13 =)
Arquivo Editar Exibir Faixas |nserir Efeitos Analisar Ajuda
[T = E E
FESEAEH (bl
Sl k| 4w 24 0 ﬁv 24 0
LJe] iy Jc LA | @ o | 2|2 |ARL,
~ o =
[Clipe so »] 1,0
ooooooooooo
it flt 51
Mudo | Solo
0,0
@
! ]
Fy

Inicio da Selegdo: @ Final (O Tamanho Posig&o do dudio:

|EIOOO ~ Antecipagdo [ (00h00mO0sw 00h00OmO0s~ 00h00OmOO sw 13
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Trilhas ou Faixas ou Pistas

No eixo horizontal, apresenta-se a duracao (curto/

longo) e a frequéncia (agudo/grave) do som, ao
passo que no eixo vertical € indicada a amplitude das
ondas sonoras, que proporcionarda a intensidade

sonora (forte/fraco).

14
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Trilhas ou Faixas ou Pistas

No meio da trilha ha uma linha que significa zero de
amplitude. Quanto mais proxima a onda sonora
estiver desse eixo, mais fraco sera o som. Se estiver,
por outro lado, aproximando-se dos extremos
verticals da trilha (consequentemente afastando-se
da linha zero), teremos um som mais forte.

1,0

2.5

0,0

'D.E 4

-1,0

15
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Editar

Os comandos para editar (alterar) um arquivo estao
disponiveis na opcao “Editar’ (Edit) do menu.

(2] Clipe'som 13

&rquivo[ ‘E;ibir Faixas |nserir Efeitos Analisar Ajuda

Desfazer Importar

Separar e Recortar

|

Copiar
X(Clipe 50 o | ™
Mono, 8010 Slie
2 | 32-bit flut Apagar

/| Mudo [ S

ard 0a Selecdo

Separar e Deletar

© Silenciar
E

Q Separar
iy

Separar e criar novo

nir

Desunir

Duplicar

Areas com titulos...

Selecionar...

Encontrar cruzamentos em zero
) |- Taxa do F Mover Cursar

8000 | Salvar selegéo
Restaurar selecéo

B Area de reprodugéo

Preferéncias...

Ctri+Z [El
I D[

L 1Ir I
Cerl+ X M- - 3 |
Ctrl+AE+X
Ctrl+C

Ctri+T

Ctri+ K
Ctri+AlE+K
Ctri+L

Cerl+1
Ctrl+ A+

Ctri+]
Ctrl+Alt+]
Ctrl+D

>
>

Z

?|C) Tamanho Posigéo do dudio:

mO0 sw O0hR0O0mOO sw

16
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Selecionar

Para “Selecionar” um trecho, ou regiao, (Clip) do
audio cligue com o mause em qualguer posicao do
grafico e arraste para selecionar.

- Clipe som' 13
Arquivo Editar Exibir Faixas |nserir Efeitos Apalisar Ajuda
T «) » ) |I—Z:’£?EHE{
| POAR AP ) w24 Dﬁv 24 O
90 WL LB @] o o] 2 2]R]L,
o - : . [ =
15 30
x|Clipe so W
Mono, 8000Hz
32-bit flut
Mudo | Solo
E 0 D
&
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Recortar e Copiar

Para recortar o trecho selecionado use a opcao
Editar (Edit) > Recortar (Cut) ou Ctrl + X

E para copiar o trecho selecionado:
Editar (Edit) > Copiar (Copy) ou Ctrl + C

Arquivo[ lExibir Faixas Inserir Efeitos Analisar Ajuda

E E
Ctrl+Z D{ D}

Ww 24 0 Swl 24 0
CtrH'XM-IU]—W e | o ppg&

Crrl+Alt +X
Ctri+C
30 . ‘ 45
Ctri+T
32-bit fiut Apagar Cerl+K
w Separar e Deletar Ctri+ At +K
O silenciar Crri+L
Separ Ctri+l
Separ: Ceri+Alt+I
Unir Ctri+]
Desunir Ceri+Alt+]
Duplicar Ctrl+D
Areas com titulos... >
Seleci >
Encontrar cruzamen tos em zero Z [ 1>)
Taxa do F Mover Cursor >\ Tamanho  Posigdo do dudio:
(soo0 | sal lecéo m00 s 00h00m00 v 18
,— Rest seleg
Area de reprodug >
Prefi clas... Ctri+P
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Separ ar

Para recortar o trecho selecionado mas sem juntar os
trechos remanescentes, use a opcao

Editar (Edit) > Separar e Recortar (Split Cut)
ou Ctrl + Alt + X

x|Clipe so w| 1,
Mono, B000Hz
32-bit flut
Mudo | Solo

- +

&
E. . 9..D|05;

9
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Faixa e Clipe

Antes de continuar vamos entender alguns conceitos do

Audacity.

Quando

usamos ajre—-70

ferramenta
“Separar e
Recortar”

podemos criar |

varios “Clipes”

(Clips) em uma !

Faixa (Track).

o - Taxa do Projeto Inicic da Selego: @ Final & Tamanho Posigéo do dudio:

: |8DDD w Antecipacdo [ (00h00mZBs= 00h00m3Gsw O0hOQO mOO sw

(=

Arguivo Editar Exibir Faixas Inserir Efeitos Apalisar Ajuda

I I \:'-I W J

@

x[Clipe so_w|[ 1,8
DireitoB8000Hz
A | 32-bit flut
i | Mudo | Solo

-1

Clipel Clipe 2 Clipe 3

(<] Ea'i'xa | B

|Ta}ca atual 8000
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Ferramenta “ Dedlizar”

A ferramenta “Deslizar’” (Time Shift) “— pode ser
selecionada pelo botao “F5” ou na barra de rerramentas:

Arquivo Editar Exibir Faixas Inserir Efeitos Analisar Ajuda

i 5 - =)
.-I?]-Cj_ ; +ﬁ@ B e
o U - | i
Com essa ferramenta € possivel mover trechos de audio

para a direita ou a esquerda, onde houver espacos ao longo
da “Linha do Tempo” (Timeline).

Arquive Editar Exibir Faixas Inserir Efeitos Anpalisar Ajuda
i E| HE

Ple k| Hv 24 0 Pvl 24 0
PYe % PG T B @ i o o | 228 R,
| | - 1,0;: I | =
BiS
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Siléncio Gravando!

Para gravar com o Audacity basta conectar o microfone e
clicar no botdao com o circulo vermelho e comece a falar,

cantar, declamar no microfone.
O programa automaticamente ira criar uma nova linha de
edicao e comecar a registrar as curvas de som.

Faixas Inserir Efeitos Analisar

1 ==1¢
Pl k
# 0 MEESL LR

22
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Siléncio Gravando!

Verifigue visualmente se as curvas de som preenchem
grande parte do espaco e se elas nao ficam nem muito
peguenas nem muito grandes.

1:32,0 1:33,0 1:34,0 1:35,0 1:36,0 1:37.0 1.

Recomendado Nao Recomendado Nao Recomendado
Muito Baixo Muito Alto

http://www.tecmundo.com.br/mp3/2030-audacity-como-gravar-sons.htm 23
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Ajustando o Microfone

Na primeira tentativa de
gravacao o som ficou muito
baixo.

O problema foi resolvido
ativando o “Mic Boost” em
Aplicacoes > Som e Video
> Controle de Volume

e no menu da janela de Controle

de Volume selecionar:

Editar > Preferéncias > Mic Boost

Arquivo Editar Ajuda
I

| Reproduzir

Chawves
93 93 (e) 2
Master P D Mic Boost
:i="! = = | AL [ .
::I !é!:a
.- - -
il L i) L ) Qn

Selecionar as faixas visiveis:

¥ Master Reproduzir [

¥ PCM Reproduzir

¥ CD Reproduzir

] Microphone Reproduzir

Reproduzir 3

[ | Caprtore Gravando

[] Digital Gravando

[] CD Capture Chawves

1 Microphone Capture Chawves
Chaves

[] IEC958

L
ey P PR e i

. . 24
3€ Fechar
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Removendo Ruidos da Gravacao

Depois da gravacao pronta podemos remover os ruidos de
fundo que fazem parte da gravacao.

Por isso é recomendavel deixar o microfone ligado por
alguns instantes gravando os ruidos do ambiente.

Arquive Editar Exibir Eaixas Inserir Efeitos Analisar Ajuda

1
® |
Lo k|- 4w 24 0 Pw 24 0
EAEm B o o 2[pRR[HMI e
15 30 5

Primeiro selecionar o0
trecho da gravacao que
contém apenas 0s ruidos
do ambiente.

Inicic da Selegdo: O Final @ Tamanho Posigdo do dudio:

Cligue e arraste para selecionar o trecho de 4udo. ~ |Taxa atual 4800
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Removendo Ruidos da Gravacao

Em seguida selecionar no menu:
Efeitos > Remover Ruido

€ Aplicagdes Locais Sistema M) - e D) i )@, B sab 29 Jun, 19:30 @
(= Projeto | =)@ )
Arquivo Editar Exibir Faixas Inserir [ ‘ Analisar Ajuda

Repetir Alterar tempo Ctrl+R E{

] i W { o
: Alterar altura... }9 vl 24 0
WG + )9 = Alterar tempo... b o a & T0 +

Alterar wvelocidade...

0 a5 1:00
= . L Me— Amplificar... : : ' : . '
x[Audic  +[ 1,0
Estéreo, 48000Hz Aumento de grawves...
32-bit flut 0.5+ Auto Duck. ..

Mudo | Selo
_ " D,D_-*} Compressor...
O Digitar comando MNyquist...
E g D 0,5 - Eco...
-1,0 Equalizagao...
1,0 Excluir siléncio...
0,5- Fade In
Fade Out
u,n'——_-*} 3
Inverter inicio e fim
0.5 - Inverter verticalmente
& -1,0 MNivelador. ..
MNormalizar...
Phaser...
Repetir...
Wahwah. .. >
Taxa do Projeto Inicio d plugins 1a 8 » o do dudio:
|'4EIOOO ~ Antecipagdo [| (00h00mO02s+ 00hO0OmOS sw 00h00OmOO sw

26

| Taxa atual 4800
B (@ nei@. .. [Ardui... [Clas. .. [oficin... [Info ... | & Projet... [Goo... | & [Proje... | (% Debia... |[ &
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Removendo Ruidos da Gravacao

Na janela que ira abrir clicar no botao
Perceber perfil de ruido

"é' Aplicagbes Locais Sistema (w‘@ D) - e i) ‘:N (3L @ Sé&b 29 Jun, 19:30 &
& Projeto_| =J|o2|X
Arquivo Editar Exibir Faixas Inserir Efeitos Analisar Ajuda
(1 = El ITE]
] :J L4l J |I_g“? Dl 1 ' ' 'IlDl 1 ' ' ' |
FPler kw24 0 Pw 24 0
NS AT B W |Bn @ oo | B2 2R |L .9 i
o Jia Remocaol de nuidos E3) 1:00
L L 1} 1}
%x[Audic _*] 1,0 Remogao de ruidos de Dominic Mazzoni
Estéreo, 4800(Hz P 1
32-bit flut 0.5+ EEE
Mudo | Sclo Selecione alguns segundos de dudio contendo apenas os ruidos que devern ser filtrados.
T 0 + | 0.0-=#mm8 () ando estiver pronto, clique em "Perceber perfil de ruido':
i3 erceber perfil de ruido
E 8} 0|05 P b fil d id
-1,0
1,0 Passo 2
05 - Selecione todo o dudio gue dever4 ser filtrado, escolha a quantidade de
' ruido a ser filtrado e cligue OK para remover o ruido.
0, 0 -zupons
sl Reducdo de rufdo (dB): [24 | (i
& -1,0 Suavizagdo de fregliéncia (Hz): |'150 | =}
Tempo de atague/caida (segs): '0,15 | =}
Testar egancelar @QK
| | " El
Taxa do Projeto Inicio da Seleg8o: () Final @ Tamanho Posig8o do dudio:
[as000 | v Antecipagdo [] |00h00m0Zsv [00h00mOS5 s~ 00hO0mOO s~

2

| Taxa atual 4800
& @ nei@... [Ardui... [Clés. .. [oficin... [Info ... || & Projet... [Goo... | & [Proje... || (% Debia... [[[ |
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Removendo Ruidos da Gravacao

Em seguida selecionar toda a faixa:
Editar > Selecionar > Selecionar tudo ou Ctrl + A

€ Aplicagdes Locais Sistema )¢ = ] i) e)l"n‘ @ S&b 29 Jun, 20:09 &
o Projetol | =)=
Arguivo [ ‘ Exibir Faixas Inserir Efeitos Anpalisar Ajuda
Desfazer Unir Ctri+Z ||E| ITE][
n Dl 1 ' ! ' I 1 Dl 1 ' ! ' 1
W w 24 0 ﬁv 24 0
0. Recortar X ] o] p[o]A[PEP [T e
30 a5 1:00 N
———— Copiar Ctri+C : ! : : ! : : ! :
Audi
= e Colar Ctri+V
32-bit flut
Mudo | S
L@
E. g
Separar Cerl+1
Separar e criar nowo Ctri+-Alt+1
B I'
L Areas com titulos..,

—

Mowver Cursor

Salvar selecao
Restaurar selegao

Area de reprodugao

Preferéncias...
Taxa do Projeto

Inicio da Selegdo:

> A esquerda do cursor [
A direita do cursor 1
>
Crl+P [>)

) Final @ Tamanho Posig8o do dudio:

28

|'48c|oc| ~ Antecipagdo [| (00h00mO0sw 00h01l mO7 sw 00hO0OmOO s=
| Taxa atual 4800
E 3 nei@... [Ardui... [oficin... | i Info ... || @ Projet... || & Edit ... "% Debia... || &

& Projet..,
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Remover partesda gravacao

Em seguida recortar o trecho inicial da gravacao que
contem apenas ruido:

Editar (Edit) > Recortar (Cut) ou Ctrl + X

(2 Clipe som 13 E@E

grquivo[ ‘Egibir Faixas Inserir Efeitos Apalisar Ajuda

Desfazer Import Cerl+Z [E| El
. esfazer Importar r o ., I
ol 340 pv 34 0

WG Qri+X ) || 2| 2|22,
E| Separar e Recortar Ctri+Alt+X
IQopiar Ctrl+C
. 3|0 . . 4|5
X[Clie = S[Streremfore 5 Selecho Ctri+T
32-bit fiut Apagar Ctri+K
w Separar e Deletar Ctri+Alt+1<
@ Silenciar Cri+L
E
O Separar Ctri+|
= Separar e criar novo Ctri+Alt+1
Unir Ctri+]
Desunir Ctri4+Alt+]
Duplicar Ctri+D
Areas com titulos... >
Selecionar... >
Encontrar cruzamentos em zero Z [ B
Taxa do F Mover Cursor >0 Tarmanho  Posigdo do dudio:
8000 | Salvar selegdo m00sw 00hOOmOO sv
Ii Restaurar selecéo |
Area de reprodugéo > 29

Preferéncias... Ctri+P




Inserindo um fundo musical

Para Inserir um fundo musical basta importar um
arquivo: Arqguivo > Importar > Audio ...

o
o
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Sincronizando

Para selecionar qual parte da mdusica sera usada
como fundo musical, pode usar a ferramenta
Deslizar.

Arquivo Editar Exibir Faixas Inserir Efeitos nalisar uda

i 5 - _

."h:]o_ (i, +ﬁo_ T o | |

g
1,0
=S LLHLLL‘IIL |”‘

0,0-

2ol ¢ >

g .

o,owwmﬂdm%%w*%*———*—
_|:||5 4
-1
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| ncluindo Espacos

E possivel dividir a gravacdo em clipes selecionando
a regiao que sera separada e:
Editar (Edit) > Separar e Recortar (Split Cut)
ou Ctrl + Alt + X

1,0
IHES -
0,0-
_[]|5 4
-1,0
5

oro-Wth%*“%‘ S—
_C||5 i
-1,0

1,0

0,54

":'|5 i
-1,0

32
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Ferramento Envelope

Para ajustar o volume do fundo musical ao longo da
mixagem utilizamos a ferramenta Envelope clicando
na barra de ferramentas ou na tecla F2

E
Efeitos Analisar Aju
, | X [H

> ek -m
=) = | | 3 (4

B3
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Ferramento Envelope

A ferramenta envelope permite criar pontos d
controle ao longo da faixa para fazer o volume c
fundo musical aumentar ou diminuir ao longo ¢

tempo.

e
O
O

Basta clicar nos locais da trilha onde se quer alterar
o volume para criar os pontos de controle e
movimentar para cima ou para baixo para controlar

o0 volume.

7.0
I

8.0 9.0 10.0 11.0 12.0
| | | 1 | 1 | 1 |

[ % Mix -
Mono, 44100Hz
16-bit PCM

Mute Solo

o

1. k

®

1.0

0.5-

0.0-

-0.5 -
-1.0
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Mixar e Renderizar

Depois de ajustar os niveis de volume ao longo da
narracao e remover trechos do fundo musical so
falta “juntar” as duas faixas (gravacao e fundo
musical) em um Unico arquivo mixado.

Isso pode ser feito pelo comando Exportar
Arquivo > Exportar

Ou selecionando todas as faixas e selecionando o

comando Mixar e renderizar
Ctrl + A > Faixas > Mixar e renderizar

35
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Mixar e Renderizar

Projeto com as duas faixas antes de Mixar e
Renderizar:

x|Audic w| 1,0

Estéreo, 4800{Hg 5 -
32-bit flut

Mudo | Solo | 9.0~

L 0 t 105

e o o -1,0

1,0

0,5 -

0,0-

_|:||5 4

& -1,0

x|Chopin - +| 1,0
Estéreo, 4410(Hz - |

32-bit flut
Mudo | Solo | g,0
- +

@ 051

E O [ 1,0

1,0
0,5+
0}0%? e e e s e *-.w»—t—.m i e, e ’HW
-0.54 T .

36




Mixar e Renderizar

17:47:10

Projeto com as duas faixas combinada em apenas
uma faixa apos a Mixar e Renderizar.

| Mix

v

Estéreo, 4800
32-bit flut

Mudo | Solo

E

©

gt

¥

1,0
1Hz

0,24

0,0

-0,5 -

-1,0
1,0

0,24

0,0

-0,5 -

-1,0
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17:47:10

Salvar Projeto

Salvar o projeto no formato “.aup”, para editar

mais tarde ser novamente aberto e editato.
Arquivo > Salvar projeto como ...

E escolher o nome do projeto e a pasta.

€ Aplicagdes Locals Sistema )6 - L] o) i BB ELE) sab 06 U, 1811 @

= Pallo’ Estevaoll EEE]

[ IEditar Exibir Faixas Inserir Efeitos Analisar Ajuda

7 = E E

Novlo Cerl+N ) [I=¢ D} o ‘D} —

Abrir.. Ctri+0 2le kD e 24 0 };' 24 0

Arguivos recentes > Z

£ e me @[] o[ p]2[2]L o
Fechar Cor+W oo 1:30 2:00 L] 2:30 3:00 3:30 4:00 4:30 5:00 5:30
T O O O MU WS
m’“’ |
......

Abrir editor de Metadados...

Importar >'* H '

Exportar...

Exportar miltiplos. ..
Aplicar arquivo de lote... o T T s = e s s SR

Editar arquivos de lote...

Configurar pagina

Imprirmir... *

Sair Ctri+Q

& |
0,0
-1,0]
Taxa do Projeto Inicio da Selegdo: O Final ® Tamanho Pesigdo do dudio:
(95000 | ~ Antecipagio [ [00h02m10=4 (0000 m00 =+ 00h00mO0 s= 38

E |3 nei.. [Ent... [FE... [Bai... [20... [Info... [ofic... [ofic... | & Paul. || [& Debi.. | &




17:47:11

Exportar arquivo paramp3

Para exportar o atual projeto para um arquivo no
formato mp3:

Arquivo > Exportar

Selecionar o formato “mp3”, 0 nome do arquivo e
a pasta.

O projeto também pode ser exportado para outros
formatos: wavy, alff, ogg vorbis e flac.

B3



Diferenca entre Salvar o Projeto e Exportar o
Projeto

Quando Salvamos um Projeto, guardamos todas as
Informacoes das faixas e clipes em um arquivo com a
extensao (.aup) o qual pode ser aberto futuramente para
ser editado pelo programa Audacity.

Mas quando Exportamos um Projeto em um formato
(mp3 ou wav) perdemos as informacoes do projeto (faixas
e clipes) e o arquivo exportado pode apenas ser lido por
um programa “tocador” de audio, mas nao pode ser
editado “diretamente” pelo Audacity.

Qualguer arquivo mp3 ou wav deve antes ser Importado
antes de ser editado pelo Audacity.
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Bom Trabalho!
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